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اتصال به یک روتر شبکه
پخش کننده خود را با استفاده از یکی از روش های شرح داده شده در این صفحه به روتر 

شبکه وصل کنید.

شبکه سیمی ❙

نکات ✎
بسته به روتر مورد استفاده یا سیاست های ISP شما شاید دسترسی اینترنتی به سرور بروزرسانی  ●

نرم افزاری Samsung ممکن نباشد. برای آگاهی بیشتر با ISP )سرویس دهنده اینترنتی( خود تماس 
بگیرید.

کاربران DSL توجه کنند که برای برقراری اتصال شبکه باید از روتر خود استفاده کنند. ●
برای استفاده از قابلیت AllShare باید کامپیوتر خود را مطابق شکل های سمت چپ به شبکه  ●

وصل کنید. اتصال می تواند سیمی یا بیسیم باشد.

سرویس باند 
گسترده

 مودم باند گسترده 
)با روتر داخلی(

مودم باند گسترده 

روتر

یا

سرویس باند 
گسترده

شبکه بیسیم ❙

نکات ✎
لطفاً جهت کسب اطلاعات بیشتر به دفترچه راهنمای پخش کننده خود مراجعه کنید. ●

+

سرویس باند گسترده

روتر بیسیم اگر پخش کننده از مدل های دارای Wi-Fi داخلی 
نیست، می بایست از مبدل LAN بیسیم 

Samsung استفاده کنید.
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پیکربندی اتصال شبکه: مراحل نخست

دکمه ]HOME[ روی کنترل از راه دور را فشار   1
دهید.

اگر شبکه شما بیسیم است، اطمینان حاصل کنید  ※
اکسس پوینتی که می خواهید پخش کننده خود را به 

آن وصل کنید روشن باشد.  اکسس پوینت می تواند یک 
روتر بیسیم، مودم و غیره باشد. اگر شبکه شما سیمی 
است، یک سر کابل LAN را به درگاه LAN پشت پخش 

کننده و سر دیگر آنرا به روتر یا مودم وصل کنید.

در صفحه اصلی به گزینه   2
>تامیظنت< رفته و 

سپس دکمه s را فشار 
دهید.

3  به گزینه >شبکه< رفته  
و سپس دکمه s را 

فشار دهید.

به گزینه >تنظیمات   4
شبکه< رفته و سپس 
دکم  s را فشار دهید.

هنگامی که پنجره   5
تنظیمات شبکه نمایش 

داده شد برای تکمیل 
پیکربندی شبکه به 

دستورالعمل های "برای 
شبکه سیمی" در صفحه 
5 یا "برای شبکه بیسیم" 

در صفحه 6 مراجعه 
کنید.

※  ))WPS )PBC ،پخش کننده شما از شیوه های مختلف پیکربندی شبکه پشتیبانی می کند )سیمی/بیسیم
که با استفاده از آنها می توانید شبکه خود را خیلی سریع و آسان پیکربندی کنید.

HOME SMART

HUB
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برای شبکه سیمی ❙

سیمی - خودکار

اگر شبکه شما نیازمند یک آدرس IP استاتیک نیست از شیوه خودکار استفاده کنید. 
بیشتر شبکه ها نیازی به آدرس IP استاتیک ندارند.

گزینه شروع را در منوی   1
تنظیمات شبکه انتخاب 
 s کرده و سپس دکمه

را فشار دهید. 

>شروع< معمولاً بطور  ✎
خودکار برجسته شده است.

پخش کننده اتصال   2
شبکه را بررسی کرده و 

سپس به شبکه وصل می 
 شود. 

هنگامی که روال اتصال 
شبکه تکمیل شد دکمه 

s را فشار دهید.

سیمی - پیکربندی دستی

اگر آدرس IP شما استاتیک است و یا روال خودکار کار نمی کند، باید مقادیر تنظیم 
شبکه را دستی وارد کنید. 

 s گزینه شروع را در صفحه تنظیمات شبکه انتخاب کرده و سپس دکمه  1
را فشار دهید. صفحه وضعیت شبکه نمایان می شود. پخش کننده سعی می 

کند اتصال شبکه را بررسی کند و موفق نمی شود. 

گزینه >IP تامیظنت<   2
را از سمت راست صفحه 

انتخاب کرده و سپس 
دکمه s را فشار دهید. 

صفحه تنظیمات IP نمایان 
می شود.

قسمت IP تلاح را انتخاب کرده و آنرا روی دستی تنظیم کنید.  3



6 - فارسی

برای وارد کردن مقادیر شبکه از صفحه کلید عددی روی کنترل از راه دور خود   4
استفاده کنید. برای رفتن از یک قسمت ورود به یک قسمت ورود دیگر از دکمه 

های ▲▼◄► استفاده کنید.

شما می توانید این مقادیر را از سرویس دهنده اینترنت خود دریافت کنید. شما همچنین می  ✎
توانید این مقادیر را در اکثر کامپیوترهای تحت Windows مشاهده کنید.

بعد از اتمام کار،  لوبق را   5
برجسته ساخته و سپس 
دکمه s را فشار دهید. 

پخش کننده اتصال 
شبکه را بررسی کرده و 

سپس به شبکه وصل می 
شود. 

برای شبکه بیسیم ❙

اطمینان حاصل کنید اکسس پوینتی که می خواهید پخش کننده خود را به آن   1
وصل کنید روشن باشد.  اکسس پوینت می تواند یک روتر بیسیم، مودم یا غیره 

باشد.

گزینه شروع را در منوی   2
تنظیمات شبکه انتخاب 
 s کرده و سپس دکمه

را فشار دهید.

>شروع< بطور خودکار  ✎
برجسته شده است.

دکمه s را فشار دهید.   3
پخش کننده شما به 
اسکن کردن اکسس 

پوینت های موجود می 
پردازد. بعد از اتمام کار 

فهرستی از اکسس پوینت 
های یافت شده به نمایش 

در می آید.
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به اکسس پوینتی که می   4
خواهید پخش کننده خود 
را به آن وصل کنید رفته و 
سپس دکمه s را فشار 

دهید. >بعدی< بطور 
خودکار برجسته شده 

است.

دکمه s را فشار دهید.   5
پخش کننده به شبکه 

وصل می شود.

اگر پنجره ورود کلید امنیتی  ✎
شبکه نمایان شد. از صفحه 

کلید برای وارد کردن کلید 
استفاده کنید. بعد از 
اتمام کار، از دکمه های 

▲▼◄► برای انتخاب 
 بعدی استفاده کرده، دکمه 
s را فشار دهید، و سپس 

به مرحله 6 بروید.

اگر می خواهید از یک   1-5
آدرس IP ثابت استفاده 

کنید، گزینه >تنظیمات 
IP< را روی صفحه انتخاب 

کرده و سپس تنظیمات 
مورد نیاز آدرس IP را بطور 

دستی وارد کنید.
IP سردآ -
هكبشرکز كسام -
یو تیگ -
DNS رورس -

هنگامی که پیکربندی   6
تنظیمات شبکه را 

به پایان بردید، دکمه 
>قبول< را فشار دهید.

✔  WPS در صورت استفاده از تجهیزات پشتیبانی کننده از
مراحل 1 تا 5 قسمت "پیکربندی شبکه: مراحل نخست" را انجام دهید.. 1
")WPS)PBC" را انتخاب کنید.. 2
دستورات نمایش داده شده روی صفحه را اجرا کنید.. 3

نکات ✎
دستگاه هایی که از WPS پشتیبانی می کنند یک دکمه )WPS)PBC دارند.    -
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نصب و استفاده از نرم افزار AllShare در 
کامپیوتر خود

❙ AllShare برای دانلود نرم افزار

برای استفاده از AllShare با کامپیوتر یا وسیله DLNA باید نرم افزار AllShare را در 
 کامپیوتر خود نصب کنید. 

برای دانلود نرم افزار AllShare و دریافت راهنمایی های مشروح درباره استفاده از 
AllShare می توانید به وب سایت Samsung.com مراجعه کنید. 

به سایت www.samsung.com بروید.   1

روی قسمت پشتیبانی در بالای صفحه کلیک کنید.   2

در صفحه پشتیبانی، شماره مدل پخش کننده را در قسمت شماره مدل وارد   3
کرده و سپس روی دکمه یافتن محصول کلیک کنید.

در صفحه ای که باز می شود روی دریافت دانلودها در سمت چپ زیر قسمت   4
دانلودها کلیک کنید. مرکز دانلود باز می شود. 

در صفحه مرکز دانلود روی زبانه نرم افزار کلیک کنید.   5

در زبانه نرم افزار روی نماد فایل سمت راست خط AllShare کلیک کنید.  6

در پنجره ای که باز می شود روی ذخیره فایل کلیک کنید.   7

فایل نصب AllShare را در دیسک خود پیدا کرده و سپس روی فایل دو بار کلیک   8
کنید. 

در پنجره ای که باز می شود روی اجرا کلیک کرده و دستوراتی که روی صفحه   9
نمایان می شود را دنبال کنید.
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❙ AllShare نصب

برای نصب نرم افزار AllShare مراحل زیر را انجام دهید.

بعد از دانلود نرم افزار AllShare، فایل نصب را اجرا کنید.  1

زبان دلخواه را انتخاب کرده   2
و روی "OK" کلیک کنید.

محل نصب نرم افزار و   3
توافقنامه مجوز استفاده 

را مرور کرده و در صورت 
 I accept" موافقت گزینه

 the terms of the
 "license agreement

را انتخاب کرده و روی 
"Next" کلیک کنید.

فایل های مورد نیاز برای   4
کار نرم افزار نصب می 

شوند.

بعد از اینکه نصب به   5
پایان رسید و میانبرها 

ایجاد شدند، اجرا شدن 
یا اجرا نشدن نرم افزار در 

آن زمان را انتخاب کرده 
و سپس برای پایان دادن 
 "Finish" به نصب روی

کلیک کنید.
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❙ AllShare قسمت های مختلف صفحه

نرم افزار AllShare سه صفحه دارد.
صفحه مدیریت فایل

برای رفتن به صفحه مدیریت فایل 
 View > File management یا

screen mode را از منوی بالا 
 File انتخاب کرده و یا روی دکمه

 management screen mode
کلیک کنید.

A .ناحیه مرورگر
Connected shared device: محتواهای اشتراک گذاری شده در دستگاه های متصل به  ●

کامپیوتر شما را نشان می دهد )بعنوان کامپیوتر من روی صفحه مشخص می شود(.
Content list: محتواها را بر اساس گروه بندی های فیلم/عکس/موسیقی نشان می دهد. ●
Transfer/Back up list: وضعیت پیشرفت/تکمیل عملیات انتقال و تهیه پشتیبان را نشان  ●

می دهد.
Playlist: می توانید یک فهرست اختصاصی از آهنگ ها، عکس ها و یا فیلم ها ساخته و  ●

پخش کنید.

B .ناحیه فهرست محتواها
محتواهای فهرستی که در ناحیه مرورگر انتخاب کرده اید را نشان می دهد. ●

C . دکمه های پخش در وسیله دیگر/انتقال به وسیله دیگر/ذخیره در
کامپیوتر من

Play on another device: صفحه انتخاب وسیله ای که می خواهید محتواهای انتخاب شده  ●
را در آن پخش کنید باز می کند.

Transfer to another device: صفحه انتخاب وسیله ای که می خواهید محتواهای انتخاب  ●
شده را به آن منتقل کنید باز می کند.

Save to My Computer: صفحه انتخاب پوشه ای که می خواهید محتواهای انتخاب شده را  ●
در آن ذخیره کنید باز می کند.

D .ویژگی های تکمیلی
Refresh: کل فهرست را تجدید می کند. ●
List view/Thumbnail view: برای تغییر شیوه نمایش فهرست کلیک کنید. ●
جستجو: محتواها را در ناحیه فهرست محتواها جستجو می کند. ●

E .Player control screen mode
به حالت صفحه کنترل پخش کننده می رود. ●
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در تنظیمات امتیازات کامپیوتر من، امتیازات اشتراک گذاری که هر وسیله وصل   2
شده برای پوشه اشتراکی کامپیوتر من دارد را تنظیم کنید.

اگر همیشه مجاز را انتخاب کنید، وسایل می توانند در نخستین باری که  ●
درخواست دسترسی می کنند بدون باز شدن یک پنجره تذکر از محتواهای 

به اشتراک گذاشته شده در کامپیوتر من استفاده کنند.
Allow all/Forbid all: امتیاز دسترسی کلیه وسایل وصل شده را مجاز/ممنوع  ●

می سازد.
شما می توانید امتیاز دسترسی هر وسیله وصل شده را با انتخاب مجاز/ ●

ممنوع که در کنار هر وسیله وصل شده در فهرست موجود است، تنظیم 
کنید.

برای حذف یک وسیله از فهرست، روی دکمه  در کنار وسیله کلیک کنید. ●

در قسمت اجازه پخش از راه دور روی کامپیوتر من، قوانین پخش از راه دور را برای   3
وسیله ای که به کامپیوتر من وصل می شود تعیین کنید.

"Always show pop-up when playback is requested": در صورت  ●
انتخاب این گزینه، AllShare درخواست پخش وسایل دیگر به کامپیوتر من را 

در یک پنجره تذکر نمایش خواهد داد.
Always allow: هنگامی که وسیله ای یک درخواست پخش به کامپیوتر  ●

من می فرستد، اجازه پخش بدون باز شدن پنجره تذکر داده می شود.
Never allow: وسایل نمی توانند روی کامپیوتر من پخش کنند. ●

اتصال به پخش کننده و سایر وسایل سازگار 
DLNA با

پیش از اینکه بتوانید به وسیله ای وصل شوید، باید کامپیوتر را به شبکه خانگی خود 
وصل کنید.

نکات ✎
اگر در روند اتصال به شبکه خانگی با مشکل روبرو شده اید، لطفاً با مدیر شبکه و یا ارائه  -

کننده روتر/ISP خود تماس بگیرید.
اگر در روند اتصال به یک وسیله DLNA )بعنوان مثال: یک تلفن همراه( با مشکل برخورد کرده اید،  -

لطفاً به دفترچه راهنمای آن وسیله مراجعه کنید.

اجازه دسترسی دادن به یک وسیله متصل ❙

 Tools > به زبانه  1
 Settings > Privilege

settings بروید.
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افزودن پوشه های اشتراکی
شما می توانید با انجام یکی از کارهای زیر یک پوشه اشتراکی اضافه کنید:

در صفحه مدیریت فایل روی دکمه  پوشه اشتراکی در بالای فهرست وسایل در سمت چپ  ●
کلیک کنید، پوشه ای که می خواهید از فهرست نمایش داده شده اشتراک گذاری کنید را 

انتخاب کنید و سپس روی تایید کلیک کنید.
روی File > Add shared folder from My Computer، پوشه ای که می خواهید از  ●

فهرست نمایش داده شده اشتراک گذاری کنید را انتخاب کنید و سپس روی تایید کلیک 
کنید.

روی Tools > Settings > Folder Settings > Add Shared Folder کلیک کنید.  ●
پوشه ای را از فهرستی که نمایش داده می شود انتخاب کرده و در فهرست و سپس در زبانه 

تنظیمات پوشه روی تایید کلیک کنید.

افزودن یک فایل به پوشه اشتراکی کامپیوتر من

شما می توانید با انجام یکی از کارهای زیر یک فایل به پوشه اشتراکی اضافه کنید:
●  Add در سمت راست، روی My Computer's Shared Folder در صفحه مدیریت فایل، در

files to play to the list کلیک کنید. در پنجره فایلی که باز می شود، فایل هایی که می 
خواهید اشتراک گذاری کنید را انتخاب کرده و سپس روی Open کلیک کنید. در پنجره ای 
که بعد از آن باز می شود روی کپی، جابجایی یا لغو کلیک کنید. اگر روی کپی یا جابجایی 

کلیک کنید، فایل ها در صفحه مدیریت فایل نمایان خواهند شد.
روی File > Add File to My Computer's Shared Folder کلیک کنید. در پنجره فایلی  ●

که باز می شود، فایل هایی که می خواهید اشتراک گذاری کنید را انتخاب کرده و سپس 
روی Open کلیک کنید. در پنجره ای که بعد از آن باز می شود روی کپی، جابجایی یا لغو 

کلیک کنید. اگر روی کپی یا جابجایی کلیک کنید، فایل ها در صفحه مدیریت فایل نمایان 
خواهند شد.

Windows Explorer افزودن از

پوشه/فایلی که می خواهید اشتراک گذاری کنید را در Windows Explorer انتخاب 
کرده و آنرا به پوشه اشتراکی کامپیوتر من/ناحیه فهرست محتواها در صفحه مدیریت 

فایل بکشید تا پوشه/فایل اشتراکی اضافه شود.

AllShare ایجاد یک فهرست پخش در
افزودن به فهرست پخش: روی  ●

گزینه Add new playlist در 
کنار فهرست پخش کلیک کرده و 

سپس نامی برای فهرست پخش 
وارد کنید.

Play on another device : روی  ●
فهرست پخشی که می خواهید 

پخش کنید راست کلیک نموده 
 Play و مکان نمای ماوس را روی

on another device نگه دارید 
تا وسیله ای که می خواهید 

فهرست پخش در آن پخش گردد را 
انتخاب نمایید.

تغییر نام یک فهرست پخش: روی  ●
فهرست پخشی که می خواهید 

 Rename تغییر نام دهید راست کلیک کرده و برای تغییر دادن نام فهرست پخش روی گزینه
کلیک کنید.

حذف یک فهرست پخش: روی فهرست پخشی که می خواهید حذف گردد راست کلیک  ●
کرده و سپس برای حذف فهرست پخش روی گزینه Delete کلیک کنید.

افزودن محتوا به یک فهرست پخش: برای افزودن محتوا به یک فهرست پخش، فهرستی که  ●
 Device List/Content محتواهای مورد نظر شما جهت افزودن به فهرست پخش را دارد در
List ناحیه پیمایش انتخاب کرده، محتواها را از ناحیه فهرست محتوا انتخاب نموده و سپس 

محتواها را به فهرست پخش بکشید.
حذف محتوا از یک فهرست پخش: فهرست پخشی که محتواهای مورد نظر جهت حذف  ●

را دارد انتخاب کنید، محتواهایی که می خواهید حذف کنید را از ناحیه فهرست محتوا 
انتخاب کرده و سپس یا روی محتوا راست کلیک کرده و روی Delete کلیک کنید یا دکمه 

 حذف را فشار دهید تا محتواها حذف گردند.
)حذف محتواها از فهرست پخش باعث حذف آنها از فهرست وسیله یا فهرست محتوا 

نخواهد شد.(
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 AllShare Play انتخاب یک وسیله در صفحه
پخش کننده خود

وسایل دلخواه را به شبکه سیمی/بیسیم خود وصل کنید.  1

گزینه AllShare Play را در صفحه اصلی پخش کننده دیسک Blu-ray انتخاب   2
کرده و سپس محتواهای مورد نظر جهت پخش )فیلم، عکس، موسیقی( را 

انتخاب نمایید.

در سمت راست صفحه،   3
وسیله ای که محتواهای 
مورد نظر جهت پخش را 

دارد انتخاب کنید.

نکات ✎
حتی اگر AllShare نصب نشده باشد، می توان وسایل DLNA را وصل کرد و آنها در صفحه  -

AllShare Play پخش کننده شما نمایان خواهند شد. )آنها باید ابتدا به شبکه وصل شده 
باشند.(

وسایلی که با دستگاه های Samsung سازگاری ندارند را نمی توان وصل کرد. -

پخش با سایر وسایل از طریق پخش کننده 
Blu-ray دیسک

 تلفن های هوشمند می توانند برای پخش فایل از طریق پخش  ❙
کننده دیسک Blu-ray به یک کامپیوتر وصل شوند. 

از تلفن هوشمند خود برای مشاهده فایل های ذخیره شده در کامپیوتر استفاده کرده و 
 سپس فایل انتخابی را از طریق پخش کننده دیسک Blu-ray خود در تلویزیون پخش کنید.

)این قابلیت فقط برای تلفن های Samsung که از عملکرد AllShare پشتیبانی می 
کنند در دسترس می باشد.(

کامپیوتر، تلفن هوشمند و پخش کننده دیسک Blu-ray خود را به شبکه   1
سیمی/بیسیم خود وصل کنید.

برنامه AllShare را در کامپیوتر خود اجرا کنید.  2

کامپیوتر

AllShare اتصال
 کنترل فایل کامپیوتر 
Blu-ray در پخش کننده

تلفن هوشمند

Blu-ray پخش کننده دیسک

پخش فایل کامپیوتر
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برنامه AllShare را در تلفن خود اجرا نموده و آنرا به کامپیوتر وصل کنید.   3
)احتیاط: به نام کامپیوتر نیاز می باشد.( 

اتصال به تلفن را در کامپیوتر تایید کنید.  4

بعد از اتصال می توانید فایل های اشتراک گذاری شده از کامپیوتر را در تلفن   5
مشاهده کنید.

فایل دلخواه را از فهرست اشتراک انتخاب کنید، سپس وسیله پخش )پخش   6
کننده دیسک Blu-ray( را انتخاب نمایید. 

تایید کنید که پخش کننده دیسک Blu-ray فایل را پخش می کند.  7

پخش فایل های فیلم از کامپیوتر من در پخش کننده ❙

آیا می خواهید بجای اینکه فیلمی را تنها در کامپیوتر تماشا کنید، آنرا از طریق پخش 
 کننده روی تلویزیون نمایش دهید تا همه اعضای خانواده بتوانند از فیلم لذت ببرند؟

 از AllShare برای منتقل کردن محتواها به پخش کننده خود استفاده کنید.
محتواها یا یک پوشه اشتراکی محتوی اقلامی که می خواهید پخش کنید را اضافه 

نمایید.

پخش کننده را روشن کنید.  1

نرم افزار کامپیوتری AllShare را اجرا کنید.  2

کامپیوتر

AllShare اتصال

Blu-ray پخش کننده دیسک

پخش فایل کامپیوتر
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اگر پوشه محتوی فیلم   3
مورد نظر جهت پخش 
اشتراک گذاری نشده 
است، روی دکمه کنار 

 My computer’s"
shared folder" کلیک 
کنید تا پوشه اشتراکی 

اضافه شود.

اگر تعداد فایل ها زیاد باشد،  ✎
بازسازی فهرست ممکن است 

به زمان زیادی نیاز داشته 
باشد.

در فهرست محتواها،   4
فیلمی که می خواهید 

پخش شود را انتخاب 
کنید.

 Play on" روی دکمه  5
another device" کلیک 

کنید.

وسیله ای که می خواهید   6
محتواها را در آن یا از طریق 
Blu- پخش کننده دیسک(
ray( پخش کنید، انتخاب 

نمایید.

هنگامی که بافر کردن   7
فیلم به پایان رسید، فیلم 

توسط پخش کننده 
پخش شده و روی صفحه 
تلویزیون مشاهده خواهد 

شد.

اطمینان حاصل کنید که  ✎
تلویزیون خود را روی منبعی 
تنظیم نموده باشید که به 

پخش کننده Blu-ray وصل 
کرده اید.



16 - فارسی

پخش فایل های فیلم از تلفن هوشمند در پخش کننده ❙

یک تلفن هوشمند و پخش کننده دیسک Blu-ray را به شبکه سیمی/بیسیم   1
خود وصل کنید.

گزینه AllShare Play را در منوی خانه پخش کننده دیسک Blu-ray انتخاب   2
کنید. 

برنامه AllShare app را در تلفن هوشمند خود اجرا کنید. منوی پخش فایل از   3
تلفن در یک پخش کننده دیگر را در AllShare انتخاب کنید.

محتواهای مورد نظر )فیلم، عکس، یا موسیقی( برای پخش را انتخاب کنید.   4
سپس وسیله ای که می خواهید کلیپ رسانه ای روی آن پخش شود را انتخاب 

نمایید.

بعد از اتصال، می توانید   5
پیام اجازه دادن را در پخش 

 Blu-ray کننده دیسک
خود مشاهده کنید.

در پیامی که باز می شود گزینه ناكما را انتخاب کرده و سپس دکمه s را   6
فشار دهید.

نکات ✎
>ناكما< بطور خودکار برجسته شده است. -
در صورتیکه AllShare در تلفن هوشمند نصب نشده باشد، این قابلیت پشتیبانی نخواهد شد. -

تلفن هوشمند

AllShare اتصال

Blu-ray پخش کننده دیسک

پخش فایل تلفن 
هوشمند
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پرسش و پاسخ
من AllShare را در کامپیوتر خود نصب کرده ام، اما نمی توانم کامپیوتر من را در برنامه 

AllShare app پخش کننده خود پیدا کنم.
مطمئن شوید که پخش کننده و کامپیوتر به برق وصل بوده و اتصال آنها برقرار باشد. ●
مطمئن شوید که اتصال کابل های شبکه )روتر به کامپیوتر، روتر به مودم و غیره( وصل بوده  ●

و برقرار باشند.
مطمئن شوید که پخش کننده به شبکه وصل بوده و پیکربندی شبکه پخش کننده درست  ●

باشد.
مطمئن شوید که به پخش کننده و کامپیوتر آدرس های IP داده شده باشد. ●
مطمئن شوید که پخش کننده و کامپیوتر به شبکه واحدی وصل شده باشند. سه سری  ●

عدد ابتدای آدرس های IP را با هم مقایسه کنید. باید یکسان باشند.
●  )Allshare امتیازات( Allshare Privilege مطمئن شوید که پخش کننده را در زبانه تنظیمات

.)Tools < Settings < Privilege settings( کامپیوتر روی مجاز تنظیم کرده اید
برخی از برنامه های فایروال مانند McAfee و Norton AntiVirus که در کامپیوتر شما در حال  ●

کار هستند می توانند مانع فعالیت AllShare و دسترسی یافتن پخش کننده به کامپیوتر 
شوند. این برنامه ها را متوقف ساخته و یا آنها را طوری تنظیم کنید که به برنامه های 

AllShare اجازه دسترسی به کامپیوتر را بدهند.

نمی توانم آدرس IP پخش کننده Blu-ray خود را در منوی تنظیم اجازه های نرم افزار 
کامپیوتری AllShare پیدا کنم.

مطمئن شوید که پخش کننده به شبکه وصل بوده و پیکربندی شبکه پخش کننده درست  ●
باشد.

مطمئن شوید که به پخش کننده و کامپیوتر آدرس های IP داده شده باشد. ●
مطمئن شوید که پخش کننده و کامپیوتر به شبکه واحدی وصل شده باشند. سه سری  ●

عدد ابتدای آدرس های IP را با هم مقایسه کنید. باید یکسان باشند.
مطمئن شوید که پخش کننده و کامپیوتر به روتر واحدی وصل شده باشند. ●
امکان دارد در برخی مدل های روتر و یا برخی پیکربندی های روتر، پخش کننده شناخته نشود.  ●

ببینید آیا روتر از مولتی کستینگ پشتیبانی می کند یا خیر. اگر از آن پشتیبانی می کند، 
پیکربندی مولتی کستینگ روتر را بررسی کنید.

نمی توانم محتواهای رسانه ای خود را علی رغم اینکه فایل در کامپیوتر بعنوان اشتراکی 
تنظیم شده است، بیابم.

AllShare از تمام فرمت های فایل برای اشتراک گذاری پشتیبانی نمی کند. فایل هایی که  ●
فرمت آنها توسط AllShare پشتیبانی نمی شود حتی اگر آنها را در کامپیوتر اشتراک گذاری 

کرده باشید، روی صفحه کامپیوتر مشاهده نخواهند شد.
شما نمی توانید فایل هایی بغیر از فیلم، عکس و یا موسیقی را مشاهده کنید. ●

هنگامی که یک فیلم را از یک وسیله USB پخش می کنم زیرنویس ها درست نشان 
داده می شوند، اما وقتی با AllShare و اتصال کامپیوتر پخش می کنم دیده نمی شوند.

مطمئن شوید که نام فایل زیرنویس دقیقاً مشابه نام فایل فیلم باشد )بعنوان مثال:  ●
Edge_City.mp4 و Edge City.srt( و هر دو فایل در یک پوشه قرار داشته باشند.

●  AllShare که با Samsung لطفاً توجه داشته باشید که این قابلیت فقط در دستگاه های
سازگار هستند پشتیبانی می شود. اگر تلفن هوشمندی که از آن استفاده می کنید 

محصول Samsung نباشد، این قابلیت پشتیبانی نخواهد شد. 


